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WINDOWS XP 

 
 

 
Introduction 
 

Microsoft Windows XP is a major upgrade of all the following 
operating systems used on personal computers: 

 
� MS-DOS 
� Microsoft Windows 
� Microsoft Windows for Workgroups 
� Microsoft Windows 95 
� Microsoft Windows 98 
� Microsoft Windows 2000 
 

 

Windows XP brings together features available in older style 
operating systems and adds to them so that you can do more 

work quicker from your desktop or portable computer. Some of 
the main benefits include: 

 
� Improved interface 
 
� Easier file management, including support for networked 
connections and long filenames. 

 

� New Plug and Play feature automatically detects and uses 
additional devices you attach to your computer. 

 
� True 32-bit multitasking enables several programs to run    
simultaneously so you can get more work done. 

 
� Improved search facility 

 
� Better multimedia support 

 
� Extended communications capability, including E-mail, 
faxes, bulletin boards, Internet. 

 

 
The basic foundation underlying Windows is its 'windowing' 

capability. A Window is a rectangular area used to display 
information or to run a program. Several Windows can be 

opened at the same time to work with multiple applications, so 
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you should be able to dramatically increase your productivity 

when using your computer. 
 

Using a Mouse 
 

� We cannot imagine using Windows Operating System with 
out a mouse. A mouse is a pointing device used to 

communicate with your computer. All operations in 
Windows environment are carried out with the help of 

mouse only. Though several keyboard equivalents (a list 
given in this chapter) are available, it is very easy and 

exciting to use mouse.  It is recommended that you use 
Microsoft, or Microsoft-compatible mouse.  

 
To use it, first place it on a flat surface or use a 

mouse mat. Optical mouse gives better 

performance than a ball mouse. It is maintenance 
free and durable and available at a very reasonable 

cost. You will notice an arrow-headed pointer 
moving on your screen as you move the mouse.  

 
To make a selection, move the mouse pointer on top of an item 

and then press and release (or click) the left mouse button. 
Sometimes you can click twice in rapid succession to select an 

item (double-click). 
 

A mouse will usually have at least one more buttons on the right 
(called the right mouse button). This provides further facilities - 

for example, a right-click of the mouse button when it is over an 
appropriate object will display a shortcut menu of related options 

pertaining to that object. This is also called as an context menu. 

 
A mouse can also be used to move items on the screen. This is 

achieved by selecting an item by clicking on it and dragging it to 
a new location holding the mouse button. 

 
In this guide, we will use the terms: Click, Double-click, Right-

click and Drag to refer to mouse operations described above. 
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You will learn the following features of Windows XP in this section 
 

� Log on to Windows XP 
� Windows XP components 
� Desktop icons 
� Communicating with Windows Operating System 
� About Windows Explorer 
� Keyboard Shortcuts 
� Practice Session I 
� Practice Session II 
� Practice Session III 
 

 Log on to Windows XP: 
 

� Switch on the computer. The system goes through a 
sequence of initialization and startup procedures. After the 

system has gone through the above startup, you will see the 
Login screen where the password for using Network services 

has to be entered. On entering the correct password, the user 
will be able to use Network services.  

 

 
� Type username in the User name textbox. 

� In the Password text box, type the password. The password 
appears as a series of ***. 

� After successful login, you will see the following screen on 
your monitor. 
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Windows XP components 
 

The Windows XP components are  
 

1. Desktop 
2. Taskbar 
 
� Desktop:  The entire screen is called the desktop. It is the 

first view after entering the password in the login screen. 
the pictures on the desktop are referred to as icons. These 

icons can be arranged in any order on the desktop. 

 
Desktop icons: 

 
 The icons on the desktop are: 

 
� My computer – It displays all the resources in the computer 

 
The most important items in this window are : 

 
� All the drives available in the computer 
� The Control Panel folder 
� The Printer Folder 
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� My Network places  – It displays the group of members 

present in the Network,  if you are working on a network  
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Some other important folders/components on the desktop are : 

 
 

� My Documents – The default folders which will hold the files 
that are created on the computer 

 
� Recycle Bin – It is the storage place for all deleted files. 

 
� My Briefcase – It helps to organize and keep documents up-

to-date between two PCs. 
 

� The Internet explorer – It opens the Microsoft Internet 
Explorer to surf through the Internet. 

 
 

Taskbar: It is the bar present at the bottom of the screen by default. 

The position can be shifted according to the user’s requirement. It 
provides access to all applications that are opened. 

 

 
 

Start button:   This button is used  to start windows Most important 

items in this menu are Programs, Documents, Settings, Search (Find) 
Help, Run and Shutdown. 

 
Each one is explained below. 

 

 

Programs  
 

Programs menu contains list of all the software installed in your 
computer.  
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     TIP  
 

To start a program 
 

� Click the Start button, and then point to Programs. 

� If the program you want is not on the menu, point to the 
folder that contains the program. 

� Click the program. 
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Documents  

 
You can quickly open a document you've worked on recently by 

using the Documents command on the Start menu. This 
command consists of 17 files that are opened recently. 

 
TIP 

 
To open a document you've used recently 

 
� Click the Start button, and then point to Documents. 

� Click the document you want to open.  
 

 

                                               
 

TIP 
 

To clear the contents of the Documents menu 
 

� Click the Start button, and then point to Settings. 
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� Click Taskbar & Start menu…, and then click the Start 

Menu Programs tab. 
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� Click on Start Menu Tab              

 

                   
 
� Select – Start – Menu – Customize – Advanced – Clear List 
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Settings 

 
Setting is used to change your computer's settings 

 
� Click the Start button, and then point to Settings. 

 

� Click Control Panel. 
 

� Double-click the icon that represents the settings you want to 
change. 

 
Run command: 

 
You can use the Run command on the Start menu to start any 

program or to open any folder, whether it is on your computer or 
on another computer on the network. 

The commands you run are saved, so you can easily run a 
command again by selecting it from the list in the Run dialog 

box. 
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� Click yes in the dialog box to shutdown the computer. 

� Only switch off when the message “It’s now safe to turn off 
your computer” appear. 

 
Searching Files 
 

Files in a computer are arranged in folders. If the location of a 
file or a folder is not traceable, Windows XP provides a search 

feature through which a file or folder can be located. The search 
feature in Windows XP is very versatile. It can not only search 

for a file or a folder in the user’s hard disk but also search for a 
file or folder in a Network. 

 
Procedure to search a file: 

 
� Click Start button and then select Search option and then 

click File or Folders. You will get below screen. 
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� In the Named text box type the file to be searched. 
� In the Look in text box select appropriate drive or click 

Browse button to select desired folder and then click Search 
Now button. (More details given in Practice Session II) 

  
Communicating with Windows Operating System 

 

Basic components of a window 
 

� Title bar is the colored bar on top of the screen and contains 
the name or title of the window, which is currently open. The 

window can be moved around on the desktop using this title 
bar. 

 

 

Minimize button:  It is used to reduce the window so that 
it appears only as a button on the task bar. 

 

 

Maximize/Restore button:  Clicking the maximize 

button enlarges the active window so that it fills the 

entire desktop 
 
 
 

Clicking the Restore button replaces the maximize button 
after the window is enlarged. Clicking the restore button 

returns window to its previous size. 

 

� Menu Bar: It is located right under the title bar. It contains 
various option names. Clicking on one of the names in this 

bar causes the drop-down menus to appear. These drop-down 
menus have different commands relevant to the contents or 

selected items in the window. 

 
 

� Status bar: It contains information or messages relevant to 
the contents or activity in the window. 
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� Scroll bars: They are provided on right side and/or bottom 

of the window, if there is data more than, what one screen of 
the window cannot accommodate, scroll bars will help to 

scroll and go through the contents of the window. 
 

Horizontal scroll bars: They allow you move to the right or 
left. 
 

 
 

Vertical scroll bars: They allow you move up or down the  
window. 

   
Scroll Buttons:    The Scroll Buttons can also be used to scroll 
the items in a window.  

 

While working in Windows environment, you will come across, some 
more windows/icons/buttons/dialog boxes etc. Each one of them is 

explained below:  
 

Command Buttons: Command button initiates action. The most 
common buttons are OK and Cancel. To confirm what is being 

displayed in the window, you click the OK button and to discard 
click Cancel. 

 

 

  Command Buttons 
Dialog Box: The windows you use while making changes to 

settings are called dialog boxes. A dialog box requests 
information from you. For example, you might need to select 

certain options, type some text or specify settings. You use 
dialog boxes to supply information throughout your work with 

windows. Dialog boxes appear when you invoke a menu option 
that has ellipses(…) beside it. They resemble the ordinary 

window but differ in few respects: a dialog box has no menus, no 
borders and cannot be sized. After the settings are specified, 

clicking on the OK button takes you back to the previous 
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window(or dialog boxes in some cases). Clicking on Cancel 

however Undo(es) the specified settings. 
 

 
 

     Dialog Box  
 

Message Box: The windows that display some message from 
the system are called Message Boxes. A message box is similar 

to a dialog box but it expects the user input in the form of 
clicking only one of its command buttons such as OK, Yes, No 

or Cancel. 
 

  

 

         Message Box 
 

Text Box: You type information into a text box. When you move 
to an empty text box, an insertion point appears. The text you 

start, appears at the insertion point. If the box you move to, 
contains text, and the text is highlighted, any text you type will 

replace it. You can also delete existing text by pressing Del or 
Backspace key. 
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List Box: It displays a list of choices. If there are more choices than 

can fit in the box, scroll bars are provided so you can move through 
the list. Usually, you can select only one item in a list box. 

 

 
     List Box 
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 Drop-Down List Box : A drop-down list box appears initially as 
a rectangular box containing the current selection. At the right 

side of it is a down arrow in the rectangular box, which when 
clicked shows the list of available choices. 

 

                                   Drop-down list box 
 

  
Option Buttons: Also known as “radio  buttons”, they represent 

a group of mutually exclusive options. It expects you to select 
only one of the options from the listed ones. If you already have 

one option selected, your current selection replaces it. The 
selected option button contains a black dot. Names of 

unavailable options appear dimmed. 
 

 

 
 
   Option Buttons 
 

 
 
 

This option is selected. 
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About Windows Explorer 
 

Windows Explorer graphically displays all the files and folders 
present in the computer. The Windows Explorer screen is divided 

into two portions. The first portion displays the entire set of 
resources in the computer. The other portion displays the 

content of a particular folder. The “+” sign next to a folder 
indicates that the folders has got subfolders within it. To expand 

a folder click on the “ + “ sign and to collapse it  again click on 
the “ - “ sign. 

 
� Windows Explorer contains Files and Folders. 
 

� The Files in the computer are similar to the files that are used in 
real life. Just as you store documents in a file for future use, 

similarly the data is stored in a computer in the form of a file. A file 
in the computer cannot exist without a name. By giving the file a 

meaningful name, you can retrieve the file easily when required. 

  
Example: Storing details pertaining to administration as Letter1,  

� As in real life you store all the files in a cabinet and give an 
appropriate label  to the cabinet, similarly in a computer, you 
store the files in a folder that is uniquely named, corresponding 

to the files it contains. 
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Example: Storing all details in a Folder ADMIN  
 
 

Getting Help 
 
  

Online Help is essential to learning and using Windows. There 
are two kinds of Help: Help about a specific procedure and Help 

that gives information about what you see on your screen. 
 

 

To Get Help 
 

 
� Click Start button and then click Help as shown above. 

� The list of Help topics appears. You can use the tabs in 
Help to search for information in several ways.   

� When you open Help by using the Start menu, or the 
Help menu in My Computer or Windows Explorer, 

you see Help for Windows in general. If you see the 
Help menu in a program, such as WordPad, Paint or 

Microsoft Word, the Help you see is for that program. 
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To find Help through the Contents 

  
� Click the Contents tab to find topics grouped by subject, 
and then follow the instructions on your screen.  

 

� To return to the list of topics, click Help Topics. 
 

To find Help through the Index 
 

� Click the Index tab to find specific topics listed 
alphabetically, and then follow the instructions on your 

screen. 

 
� Click Display button. 

 
� To return to the list of topics, click Help Topics. 
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                  To find Help Topics containing a word or phrase 
 

� Click the Find tab to find all the topics that contain a 
specific word or phrase, and then follow the instructions 

on your screen. 
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Keyboard Short Cuts 
 

In windows alternate methods are provided for all operations. 
For several operations at least three methods are provided.  

Using keyboard short cuts with a combination of Alt, Ctrl, Shift 
keys will speed up our work. But this can be achieved only by 

practice. For the benefit of participants most commonly used 

keyboard shortcuts are provided in the next page. 
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Practice Session I 

 
� Switch on the computer and wait till the Start button appear 

on the left side of the Taskbar. 
� Click on the Start button and observe the popup menu with 

the following items as shown below. 
 

 
� Move the pointer on the above items and observe a highlight 
bar appears along with the pointer as shown below. 

 
 

� Click the mouse on blank area on the desktop. 
 

You can maximize, minimize, restore and close windows. For 
example; 

� Duble click on My Computer icon and observe the My 

Computer window opened as shown below. 
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� Maximize the window by clicking on  button. 

� Restore the My computer window by clicking again on      
button. 

� Increase or decrease the size of the window by using vertical, 
horizontal and diagonal stretch arrows. 
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� Move the window to the right side bottom of the screen by 
holding the menu bar with the pointer and dragging it. 

 

� Minimize the window by clicking on button  and observe the 
My Computer becoming a task button on the taskbar. 

 
� Minimize, Maximize & close buttons in windows XP as shown 
below. 

 

 

                                                                
 

 
 

 
 

 
 

 

Vertical stretch arrow 
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� Open another window Recycle Bin on the desktop. 
 

� Minimize the Recycle Bin window by clicking on minimize 

button. 
� Observe Recycle bin becoming another task button on the 

taskbar. 
 

 

 
� Click on the My Computer button on the taskbar. 

� Click on Recycle Bin button on the taskbar. You will get a 
screen similar to this. 
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� Observe two windows are opened now on the desktop. To 
make the window behind as active window click on the Title 

bar(top line of window) 
� Switch between windows. 

� Close the windows by clicking on  button. 
� Shutdown the computer. 
� Click on Start button point to “Shut down” and click 
� Switch off the system when you get the message "It is now 
safe to turn of the computer". 
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Practice Session II 
 
Task 1 : Create a New Folder 
 

� Using the right mouse button click on any clear area of the 
desktop. 

� Desktop popup menu appears. Point to New and then move 

the mouse pointer to Folder  

 
� Click Folder. A New Folder icon appears on the desktop.  

 
� In the highlighted area of the icon type My folder and press 

enter key. 
 

Task 2 : Create a new Text Document 
 

� Click on the clear area of the desktop with the right button. 
The popup menu appears. Point to New, and then click Text 
Document. 

� In the highlighted area type Text1 and press enter. Now 
double click Text1(Notepad Application). You will get below 

screen. 
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� Type the following sentence in the Text1 file. 
 
This is a sample document. 

 
� Save the file by moving the pointer to File and then to Save 

as shown  

below 
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� Close Text1 (this window) by clicking Close button on the 

right top corner. 
 

Task 3 : Place a file in a folder 
 

� Click on Text1, hold the left mouse button, drag and drop the 

Text1 document in My Folder 
� Double click My Folder. The My Folder window is opened 
and the Text1 document is available in this window as shown 

below. 
 

� Double click Text1 to open this window. 

� Close Text1 by clicking      button. 
 

� Close My Folder window by clicking   button. 
 
Task 4 : Using Windows Explorer 
 

� Click on Start button. 
� Move the pointer to Programs on the popup menu and to 

Windows Explorer on the nested menu. 

� All folders and files appear on the screen. 
� Locate My Folder in the Windows Explorer under desktop. 
� Double click on My Folder icon. 

 
� Text1 document will appear on the right side window. 
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� Double click on Text1 document to open it. 
 

Close Text1 document by clicking  close button 

 

Close Windows Explorer window by clicking close button 

 

 

 

Task 5 : Creating a bitmap (Using Paint) 
 

� Click Start button, point to Programs, point to Accessories 

and then click Paint program. 
� Create a random bitmap by using brush, pencil or text from 
the toolbar of Paint program.  
Pencil brush   text 

        

� Save the file using Save option from the File menu. Type file 
name as Model and click Save button. 

� Exit Paint Program. 
� Drag and drop this file in My Folder. 
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Task 6 : Create a new document using Word Pad 
 

 Word pad is a basic word processor used to create and edit 
documents. 

 

� Click on Start button and move pointer to Programs, point 
to Accessories and then click WordPad. You will get below 

screen. 
 

 
� To create a new document, start typing random text in word 
pad. 

� Save the file in My Folder using Save As command from the 
File menu and then type Text2 as shown below. 
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� Click Save button. 

 
Task 7: How to use Calculator 
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� Click on Start button and move pointer to Programs, then to 

Accessories and then click Calculator. 
 

 
� The Calculator provides both Standard and Scientific 

Calculators. Above is the Standard Calculator. 
� The Scientific Calculator is displayed by clicking View menu 

and then clicking Scientific option. 

 
 

� Click on relevant buttons (similar to buttons on a hand held 
calculator) or type the values from the keyboard. 

� Exit Calculator by clicking  button. 

 
Task 8 : To set the clock and to adjust Date and Time 

� Place the pointer over the clock on the task bar and click right 
mouse button. The clock popup menu appears. 
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� Click Adjust Date/Time option. 

� The Date/Time property sheet appears. 
 

 

 
 
 

 
� Click the Time Zone tab. 

 
� The Map of global time zones appear. 
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� Select the Time Zone form the drop down list box. Select 
Bombay, Calcutta, Madras, New Delhi, Colombo. 

� Click OK button. 

 
Task 9: How to use Recycle Bin 

 
� Click on My Folder, hold left mouse button, drag and drop 

My Folder in Recycle Bin. 
� Open Recycle Bin by double clicking on the Recycle Bin 

icon. 
� To Restore Text1 document, select Text1 file and right click it 
and select Restore option. 

� To delete Text1 document, select and right click it and then 

select Delete option for permanent deletion. 
 

� Exit Recycle Bin. 
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Task 10: Change the appearance of Windows 

 
 You can personalize Windows with pictures, patterns, and colors 

by using Control Panel.  You can display pictures or patterns as 
“wallpaper” for Windows, or use your own scanned photos. You 

can also change your Windows colors to an existing scheme, or 
create your own.  

 
 Select Settings from the Start Menu then Control Panel 

 Double click on  Display icon  
TIP 

 
 You can open the Display dialog box by right clicking on the desk 

top and selecting Properties also. 
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The following screen will be seen 

 
 

  
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 Choose any of the background available in the list and click OK. 

 
Task 11: Set up a screen saver 

  
 Screen savers can save wear and tear on your screen and 

protect your work when you are away from your computer. 
Several screen savers come with Windows.  

 To setup a Screen Saver select Screen Saver tab from the 
Display Dialog box 
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Select a Screen Saver from the list and click on OK  
 

Task 12: Rename a file 
 

� Select the file, which you want to rename it. 
� Right click it to get a popup menu and then select and click 

Rename option. 
� Now you can type a new name for the selected file. 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
Task 13:  Locate file using Search 

 
� Click Start button and point to Search then click to Files or 

folders.   
You will get the following dialog box. 
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We have 3 types of Search methods. 

 
1. Search for files or folders named   2. Containing text            

3. Advanced search 
 

1. Search for files or folders named 
 

� Type name of the File to be search in Named Text box 
� Click Look In Drop down List box and Select Drive C: 

� Click Search Now button  
 

All  files with required name are displayed in the Window on the 
right side.  Now Double Click your file from the List of files to 

open it. 
 

Type some words of your file in the Containing Text text 

box(Optional), if the file name is not known. 
 

Search options 
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Click Date checkbox  from Search Options dialog box. 

 
You will get the following dialog box: 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
� Click the Between radio button and type from and to dates 

of file creation  (or) 
Select in the last ___ months/in the last____days option 

 
� Click Search Now button 

 
� Click Type list box and select file type 

� Mention the Size of the file in KB. 
� Click Search Now . 

3. Advanced 

 
� Click Advanced from Find Now dialog box 

You will get the following dialog box 
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This will allow you to search in a more advanced way by 

selecting Search Folders, Case sensitive or Search slow files as the 
case may be. 

 
 

 
Task 14: Automatically Hide the taskbar 

 
� Right Click on the taskbar and then select Properties option. 

You will get the below screen. 
 

 

 
 

 
� Check Auto hide checkbox, then click Apply, and then click 

OK. 
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Practice Session III  

 
Adding Programs to Start menu 

 
You can add the programs you use most frequently to the Start 

menu, making them easy to find and available at all times. For 
example, if you use Paint frequently, you can add it to the Start 

menu.  
 

  
 

In the above picture MS Paint is added to the Start menu 
Programs. 

 
To add a program to the Start or Programs menu 

 
� Click the Start button, and then point to Settings. 

� Click Taskbar, and then click the Start Menu Programs 
tab. 

� Click Add, and then click Browse. 

� Locate the program you want to add, and then double-click 
it. 

� Click Next, and then double-click the menu on which you 
want the program to appear. 
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� Type the name that you want to see on the menu, and 
then click Finish. 

� If Windows prompts you to choose an icon, click one, and 
then click Finish. 

 
 

Copying Files 
 
There may be instances when you want to duplicate a file or 

reasons of safety or necessity. This need can be met by the Copy 
utility, which enables you to duplicate the file within the drive, 

i.e. across folders, or within a folder under a different name 
 

To make a duplicate file: 
 

� Open the folder which contains the file 
� Holding the Ctrl key on the keyboard, drag the file to the 

destination folder. 

� Release the mouse button. 
� Release the Ctrl key. 

 
 

Another procedure to copy a file: 
 

� Open the folder, which contains the file. 
� Select the file. 
� Select Copy option from the Edit menu. 
� Click on the destination folder. 
� Select Paste option from Edit menu. 

 

 
Moving Files 

 

� Open the folder, which contains the file. 
� Select the file. 
� Select Cut option from the Edit menu. 
� Click on the destination folder. 
� Select Paste option from Edit menu. 

 

Deleting Files 
 

The files and folders that are not required can be removed from the 
hard disk by deleting them. It is always a good habit to Delete the 

unwanted files to have only the necessary information in our computer 
for use.  
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When a file is deleted, it is moved to the Recycle Bin, which is a 
storage place for deleted files. 

 
Procedure to delete a file: 

 
� Select the file from the appropriate folder 
� Select Delete from the File menu and click on Yes to move 
the contents of the file to the Recycle Bin. 

 
Another procedure to delete a file: 

 
� Select the file from the appropriate folder. 
� Press Delete on the keyboard and click on Yes to move the 
contents of the file to the Recycle bin. 

 

Recycle Bin is also a folder, which has to be cleared from time to time. 
To delete files from Recycle Bin open it, select the file to be deleted 

and delete them. 
 

Tips: 
  

� All files in the Recycle Bin can be deleted by choosing 
‘Empty Recycle Bin’ 

� Multiple files can be selected by holding Ctrl key and 
clicking on the file 

� A file can be deleted without sending it to Recycle Bin by 
clicking Shift+Delete keys. You will get following dialog 

box. 
 

 
� Now click Yes button to delete the file permanently.   

 

Note: Please note that files that are deleted from a ‘floppy’   
will not be sent to Recycle Bin. 

 
*** 


